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Introduction
INTRODUCTION

Thanks for your purchase of the E-MU 0202 USB 2.0 Audio/MIDI Interface. This 
interface brings an unparalleled level of USB audio quality to the Mac or PC, with 
pristine 24-bit/192kHz A/D and D/A converters, ultra-low jitter clock, and Class-A, 
ultra-low noise mic/line/hi-Z preamps. The signal-to-noise specs of the 
E-MU 0202 USB 2.0 are unmatched by any other USB interface on the market! 
From its plug-and-play functionality and hands-on ergonomic design, to profes-
sional features like zero-latency direct monitoring, the  USB will forever change 
your expectations of USB audio. The  USB also comes complete with the powerful 
E-MU Production Tools Software Bundle so that you have everything you need to 
create, record, edit, mix and burn your music right out of the box.

Some of the other key features are detailed below:

• Record and Playback support for a multitude of sample rates : 44.1k, 48k, 88.2k, 
96k, 176.4k, 192k.  (176.4k &192k available on PC version only) 

NOTE
There are some limitations 
when operating at higher 
sample rates. See page 15 
for details.

• Independent ground lift switches for both analog inputs help to solve potential 
ground loop problems

• Studio-Grade Headphone Amplifier with level control
0202 USB 2.0 Owner’s Manual 5



Package Includes
PACKAGE INCLUDES

• E-MU 0202 USB 2.0 AudioPod
• USB Cable
• Quick Start Installation Guide

E-MU Software/Manual CD-ROM (OS X /Windows)

• Window XP and x64 Drivers 
• Mac OS X Drivers
• Owner’s Manual and Tutorials

E-MU Production Tools Software Bundle CD-ROM (Windows)

• Cakewalk Sonar LE
• Steinberg Cubase LE
• Steinberg Wavelab Lite
• Celemony Melodyne essential
• IK Multimedia AmpliTube LE
• SFX Machine LT 
• Minnetonka diskWelder BRONZE (5-burn trial) 

E-MU Proteus VX CD-ROM (Windows)

• E-MU Proteus VX (with over 100 sounds)

E-MU Production Tools Software Bundle CD-ROM (OS X)

• BIAS Peak Express
• Celemony Melodyne essential
• IK Multimedia AmpliTube LE
• SFX Machine LT 
• Minnetonka diskWelder BRONZE (5-burn trial) 

Ableton Live Lite for E-MU CD-ROM (OS X, Windows)

• Ableton Live Lite
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Computer Requirements
COMPUTER REQUIREMENTS
The minimum computer system requirements for the E-MU 0202 USB 2.0 are 
listed below.

Windows
• Intel® or AMD® processor — 1.2 GHz or faster
• Intel, AMD, or 100% compatible motherboard & chipset
• Microsoft® Windows® XP (SP 2 or greater) or Windows XP x64
• 1 available (Hi-Speed) USB 2.0 port *
• 256 MB System RAM
• 900 MB of free hard disk space for full installation
• CD-ROM/CD-RW or DVD-ROM drive required for software installation
• XVGA Video (1024 x 768)

OS X
• Apple® Macintosh® G4 —800 MHz or faster

NOTE: For more information on Intel Mac support see the included ReadMe file, and/
or www.emu.com for latest information. 

• Apple Macintosh OS X (10.4.3 or greater)
• 1 Available (Hi-Speed) USB 2.0 port †
• 512 MB System RAM
• 500 MB of free hard disk space for full installation
• CD-ROM/CD-RW or DVD-ROM drive required for software installation
• XVGA Video (1024 X 768)

* When using a USB 1.1 port, performance is limited to16-bit and 44.1/48 kHz recording 
and playback.

† USB 1.1 is not supported on the Macintosh
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Software Installation
SOFTWARE INSTALLATION

Windows XP
Follow these instructions to install the 0202 USB 2.0 software and E-MU 
Production Tools software bundle on a Windows XP computer.

1. First connect the 0202 USB 2.0 to your computer using the supplied USB 
cable, and turn it on. 

2. If Windows prompts you with an Add New Hardware Wizard, click Cancel.

3. Insert the E-MU software Installation CD into your CD-ROM drive. If 
Windows AutoPlay mode is enabled for your CD-ROM drive, the CD starts 
running automatically. If not, from your Windows desktop, click Start->Run 
and type d:\setup.exe (replace d:\ with the drive letter of your CD-ROM 
drive). You can also simply open the CD and double-click Setup.exe.

4. The installation splash screen appears. Follow the instructions on the screen to 
complete the installation. You will have the option to install 0202 USB 2.0, 
and Adobe Acrobat Reader.

5. Choose “Continue Anyway” when you encounter the “Windows Logo 
Testing” warning screen. See the note below.

6. When prompted, restart your computer.

7. Be sure to register your 0202 USB 2.0 so we can advise you of future software 
updates and special offers. You can register online at: www.emu.com/register

8. Your 0202 USB 2.0 is now ready to use.

9. Insert the Windows Production Tools Software Bundle CD-ROM into your 
CD-ROM drive.

10. The installation splash screen appears. Follow the instructions on the screen to 
complete the installation.

Note About Windows Logo Testing
When you install the 0202 USB 2.0 drivers, you will see a dialog box that informs 
you that the driver has not passed Windows Logo testing.

However, the 0202 USB 2.0 drivers have been rigorously tested using the same test 
procedures that a signed driver requires, and it passes in all important categories, 
including those that measure the relative stability of the driver. So, it is perfectly 
safe to install these drivers on your computer.

Uninstalling all Audio Drivers and Applications 
At times you may need to uninstall or reinstall the 0202 USB 2.0 application and 
device drivers to correct problems, change configurations, or upgrade outdated 
drivers or applications. Before you begin, close the E-MU USB 2.0 Audio control 
application. Applications running during the uninstallation will not be removed.

1. Click Start -> Control Panel.

2. Double-click the Add/Remove Programs icon.

3. Click the Install/Uninstall tab (or Change or Remove Programs button).

4. Select the E-MU 0202 USB 2.0 entry and then click the Change/Remove 
button.

5. In the InstallShield Wizard dialog box, select the Remove ALL option.

6. Click the Yes button.

7. Restart your computer when prompted.

You may now re-install existing or updated E-MU device drivers or applications.
8 E-MU Systems
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Software Installation
Macintosh OS X
Follow these instructions to install the 0202 USB 2.0 drivers and software on a 
Macintosh OS X computer. First, connect the 0202 USB 2.0 to your computer as 
shown on page 12.

Install the 0202 USB 2.0 Software

1. Insert the E-MU Software/Manual CD-ROM into your CD-ROM drive.

2. Double-click on the E-MU icon on the desktop.

3. Double-click on the Install icon to start the installation.

4. The installation Welcome screen appears. Follow the instructions on the 
screen.

5. When the Authenticate dialog box appears, enter the administrator password 
you chose when you installed OS X.

6. Continue to follow the instructions on the screen to continue the installation. 
You will be given the option to install:

• Easy Install: Installs the following applications and drivers.
E-MU 0202 USB 2.0: USB Drivers and Control Application

• Custom Install: allows you to choose which components are installed.

7. Easy Install is recommended. The software will be quickly installed. When 
prompted, restart your computer.

8. Be sure to register your 0202 USB 2.0 so we can advise you of future software 
updates and special offers. You can register online at: www.emu.com/register

Set-up the 0202 USB 2.0 as your Default Audio Device

9. Click Go -> Utilities from the menu bar.

10. Double-click Audio MIDI Setup, then click the Audio Devices button if it’s 
not already selected. The window shown on the following page appears.

11. Select the 0202 USB 2.0 for the following: Default Input, Default Output, 
System Output, Properties For.

12. Play a song on iTunes to verify that the 0202 USB 2.0  is the default device for 
audio playback.

13. Quit iTunes.
0202 USB 2.0 Owner’s Manual 9
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Software Installation
Setup the MIDI Devices
If you plan to use a MIDI keyboard, now would be a good time to set up your MIDI 
devices. Connecting a MIDI keyboard will allow you to use the virtual instruments 
provided in the software bundle and get the most out of your purchase. You’ll also 
need a MIDI interface such as the E-MU Xmidi 2x2 or Xmidi 1x1.

14. Click the MIDI Devices button. The window shown below appears.

15. Click the Add Device button. A new external 
device icon like the one shown at left appears. 

16. Double-click on the new external device if you 
want to set the MIDI Keyboard Properties. You 
have the option to name and change the icon 
for the device. Click Apply, then click the Close 
button to close the Properties window.
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Software Installation
17. Connect the new external device to the E-MU 0202|USB by dragging between 
the input and output connectors.

18. The window below shows a properly connected MIDI device.

19. Press the close button to close the Audio MIDI Setup window.

Install the Production Tools Software Bundle

20. Insert the Macintosh Production Tools CD into your CD-ROM drive.

21. Double-click on the installer package.

22. The installation splash screen appears. Follow the instructions on the screen.

23. Continue to install applications from the bundle as desired,

Uninstalling the Audio Drivers and Applications
At times you may need to uninstall or reinstall the 0202 USB 2.0 application and 
device drivers to correct problems, change configurations, or upgrade outdated 
drivers or applications. Before you begin, close the E-MU USB 2.0 Audio control 
panel application. Applications running during the uninstallation will not be 
removed.

1. Open the Applications folder.

2. Open the Creative Professional folder.

3. Open the E-MU USB Audio folder.

4. Click the E-MU USB Audio Unistaller and follow the instructions.
0202 USB 2.0 Owner’s Manual 11



Connection Diagram
CONNECTION DIAGRAM

WARNING!
Use only a USB 2.0 
certified Hi-Speed cable 
(like the one supplied) for 
the USB connection. Using 
a USB 1.1 cable may cause 
erractic behavior and 
degraded performance.

Inputs

USB 2.0

Outputs

LR R - Hi Z / LineStereo

L - Mic L - Line Mic

Computer

Microphone
or Line 

1/4” male to 1/4” male
(unbalanced)

Powered Speakers
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Controls & Headphone Output
CONTROLS & HEADPHONE OUTPUT

1. Signal Level & Clip Indicators
The LED signal level indicators show that you are inputing a proper signal 
level. With a proper input level, the green signal LED should be flickering, but 
the red clip indicator should NOT ever be lit.

The clip indicators light and show that the input level has exceeded0 dBFS. 

2. Left/Right Gain Controls
These controls set the input gain from 0dB to +60dB for the two inputs.

3. Direct Monitor Level Control
This encoder controls the amount of direct monitor signal mixed into the  
outputs. The level is adjustable from -24dB to off.

4. Direct Monitor On/Off & Mono-Stereo Switch
Press the button to turn Direct Monitoring on and off and to switch modes. 
The stereo LED illuminates. The left and right channels are passed through to 
their respective outputs at the level set by the Direct Monitor Level control. 
Press the button again to sum the left and right direct monitor channels to 
mono. Mono mode is useful when the two inputs are being used for separate 
instruments. See “Direct Monitoring” on page 16.

5. Headphone Jack
Connect your stereo headphones here.

6. Headphone Level Control
This knob controls the volume of the headphone output. This switch also 
turns the 0202 USB 2.0 on or off.

2 3 4 5 61
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Input/Output
INPUT/OUTPUT

7. USB
Connects the 0202 USB 2.0 to your computer via the supplied USB cable. The 
USB connection provides two-way communication when connected to the 
computer. 

NOTE to PC Users:
When using a USB 1.1 port, 
performance is limited to
16-bit and 44.1/48 kHz 
recording and playback.

The 0202 USB 2.0 receives its power from the USB. Always connect to the USB 
jack on the computer itself and NOT to a low-power USB connection that 
may be present on your computer keyboard or other USB peripheral.

8. Main Outputs
The unbalanced outputs are normally connected to your monitoring system. 
The signal is duplicated on a stereo 1/8¨ jack for easy connection to desktop 
stereo speakers. The outputs are designed using a special noise-cancelling 
circuit which reduces problems relating to ground loops.

9. R - Hi Z / Line Input
This 1/4¨ input can be used as a Hi-Z instrument input (guitar/bass, etc.) or a 
line level input. The input is balanced, but accepts either balanced or unbal-
anced signals.

10. L - 1/8¨ Mic Input
Connect microphones with 1/8¨ plugs to this jack.

11. L - Hi-Z / Line / Mic Input

Use the XLR connector for microphones or balanced line level signals. Use the 
1/4¨ in the center of the XLR jack as a Hi-Z input for guitar/bass, or as a line 
level input. The input is balanced, but accepts either balanced or unbalanced 
signals.

� Ground Lift Switches
There are “ground lift” switches for both analog inputs located on the bottom 
of the unit. These switches can be used to safely stop the hum if a ground loop 
occurs in your setup. See page 42 for more information.

Inputs

USB 2.0

Outputs

LR R - Hi Z / LineStereo

L - Mic L - Line Mic

7 9 118 10

L-GND LIFT
R-GND LIFT

Input Ground Lifted

Input Grounded

The input ground is lifted when the A or B slide switch is closest to the GND LIFT label.
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E-MU USB Audio Control Panel
E-MU USB AUDIO CONTROL PANEL
After you have successfully installed the audio drivers, launch the E-MU USB 
Audio control panel. The E-MU USB Audio control panel is shown below.

• Windows: The E-MU USB Audio control icon will be visible in the Taskbar, 
which is normally located in the bottom right of the screen. It can 
also be launched from the Start Menu 
(All Programs, Creative Professional, E-MU USB Audio Application).

• OS X The E-MU USB Audio control application is located in the Appli-
cations folder . You can also open the E-Control Application 
using the icon on the desktop.

1. Skin
Choose between different appearances for the E-MU USB Audio control 
panel. 

2. View
Hide the application (Ctrl+H, Windows) You can restore the application by 
clicking the E-MU icon in the System Tray (Windows), or by clicking the 
E-MU icon in the Dock (OS X).

3. Help
About E-MU 0202 USB 2.0, Audio control, Launch Manual, Check Updates

4. Device
If you are using more than one E-MU USB Audio device, you can choose 
which unit is currently being controlled.

NOTE
There are some limitations 
when operating at 176.4/
192k sample rates. 

PC - No Direct Monitor

Mac - Disabled

5. Sample Rate
Allows you to set the system sample rate: 44.1kHz, 48kHz, 88.2kHz, 96kHz, 
176.4kHz or 192kHz.

1

2 3

4

5

0202 USB 2.0 Owner’s Manual 15



Direct Monitoring
DIRECT MONITORING
Direct monitoring allows you to monitor inputs without having any software 
open.  It can also be used as an alternative to software monitoring if you desire the 
lowest latency monitoring possible.

When using a computer for digital recording, an audible time delay occurs while 
the audio signal is being input to the computer, processed by the software and then 
returned to the output for monitoring. This time delay is called Latency. 

Latency becomes a problem when you have to use high buffer settings to conserve 
CPU resources. Because the 0202 USB 2.0 has hardware direct monitoring, you can 
enjoy zero latency regardless of your buffer setting. 

NOTE
Direct monitoring is not 
available at 176.4 or 
192 kHz.

The Direct Monitor feature connects the input signals to the output when recording 
so that you can hear your performance without delay. The Direct Monitor level 
control lets you adjust the volume of the input signal in relation to the recorded 
tracks.

Direct monitoring is controlled manually from the Direct Monitor switch on the 
0202 USB 2.0. It’s not necessary to turn it on in your recording application

Direct Monitoring vs. Software Monitoring 
Direct monitoring is lower latency and can also be used without software running 
(or even without a computer!).

Software monitoring has the advantage of allowing audio effects or EQ added in 
the host software to be heard on the output. Its roundtrip latency depends on what 
latency is chosen in the ASIO configuration. If you choose to software monitor, 
make sure to disable direct monitoring. If both are enabled, you will experience a 
‘comb filter’ or doubling effect.

USB

Software Monitoring

Direct Monitoring

Latency (delay)

Direct Monitoring allows you to listen to the direct sound of your instrument during 
recording, without the delay incurred by going to the computer and back.
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Tutorials
TUTORIALS

Introduction
This guide contains step-by-step walk-throughs of basic recording operations using 
your E-MU 0202 USB 2.0 interface with software applications for your Windows 
computer. We encourage you to perform the steps on your computer as you read 
so that you become familiar with the process. The first tutorial only takes about 
half an hour to complete, by which time you’ll know how to make a multitrack 
recording.

NEED MORE HELP?
If you need additional help with the bundled applications, please see: 

• Windows: Program Files\Creative Professional\E-MU 0202 
USB\Documents\3rdParty.htm.

• OS X: Applications Drive\Library\Documentation\E-MU 0202 USB\ 
3rdParty.htm

Before you Begin...
• You should have already installed the E-MU software on your computer

WARNING!
Windows Users - After 
checking your audio, be 
sure to quit Windows Media 
Player.

• You should hear the computer sounds coming out of the E-MU 0202 USB 2.0 
and your speakers when you play a CD or an MP3 using Windows Media 
Player or iTunes. If not, make sure your E-MU 0202 USB 2.0 is properly 
connected according to the diagram on page 12.

• A source of audio should be connected to the inputs (a microphone, musical 
instrument, or CD/MP3 player).

Getting Started with Steinberg Cubase LE (Windows)
Steinberg Cubase LE is a 24-bit, multi-track audio/MIDI sequencer with high-
quality effects, automation, virtual instruments (VSTi), and many other profes-
sional features.

The following step-by-step tutorials are designed to get you recording as quickly as 
possible.

1 - Setting up Cubase LE
Follow these instructions carefully to ensure that Cubase LE runs smoothly the first 
time. Cubase LE will remember these settings, so you’ll only have to do this once.

1. Open Cubase LE from the Start 
menu. An ASIO multimedia driver 
test dialog box will pop up to ask if 
you want to run the ASIO test. 
Choose No, because you won’t be 
using the driver anyway.

2. Select New Project from the File 
menu.

3. Select Empty and click OK.

4. A Select Directory pop-up dialog 
box will appear. Choose a location 
on your hard disk where you want to 
store your audio files, then click OK.

5. The Cubase LE Project window appears. 

TIP . . .
If you have two or more 
hard disks, it’s better to 
store audio files on a disk 
that isn’t running your 
OS.
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Tutorials
6. Select Device Setup… from the Devices menu.

7. Select VST Multitrack from the Devices list.

8. In the Setup section of the dialog box, select ASIO E-MU 0202|USB. A pop up 
dialog box asks, if you want to keep or switch the ASIO driver. Select Switch.

Buffer Latency Setting

9. Click the Control Panel button. 
The pop-up dialog box shown at 
right appears.

10. Set the ASIO Buffer Latency as low 
as your computer will allow and 
click OK. 
(10ms is a good starting point.)
A low latency setting is important to 
assure fast response when using vir-
tual instruments and to minimize 
delay when monitoring through Cubase. If you hear crackles or other audio 
problems, try increasing the Buffer Size. 

11. Close the Device Setup screen by clicking OK.

12. Note: If the Cubase LE application crashes for any reason, it is recommended 
that you re-boot the computer.

13. Select Project Setup from the Project menu. This is where you set the Sample 
Rate and Record Format (bit depth), among other things. Set the Record 
Format to 24-bits and the Sample Rate to 44.1kHz.
18 E-MU Systems



Tutorials
14. Select VST Inputs from the Devices menu. This is where you enable the inputs 
you wish to use. Make the inputs active.

2 - Basic Multitrack Recording 
This tutorial assumes you’re using a single input or a pair of inputs. For more 
advanced recording, refer to the Cubase LE manual.

Add an Audio Track

1. From the Cubase LE menu bar, select Project, Add Track, Audio. An audio 
track is added to the project window.

NOTE
If the Inputs aren’t available, 
check Devices, VST Inputs.

2. The screen shows the “L” input of the 0202|USB. Note that IN 1 is shown in 
the Track Input field (Input L =IN1, Input R =IN2). If you want to record in 
stereo, turn the Stereo/Mono button On and select IN 1 + IN 2 for the Track 
Input.

3. Make sure the Monitor button  is OFF. You will be monitoring the input 
through the 0202 USB 2.0.

Inspector button Stereo/Mono button

Track InputMonitor
0202 USB 2.0 Owner’s Manual 19



Tutorials
4. Press the Direct Monitor button on your E-MU 0202|USB 2.0. If you are 
recording a mono track, set Direct Monitor to Mono by pressing the Direct 
Monitor button again.

Get Ready To Record

5. Plug in your instrument or microphone and set the input gain control for a 
good signal level. The green -12 signal LED should come on, but the clip LED 
should never come on. 

6. You should be hearing your instrument or microphone through your monitor 
speakers or headphones. If not, go back to steps 4 and 5.

NOTE
Turning on the metronome 
adds a 2-bar lead-in before 
recording begins.

7. Optional Step - Metronome: To toggle the Metronome on and off, press C on 
the computer keyboard. To adjust the metronome output level, press the 
transport Play control, then select Metronome Setup... from the Transport 
menu. Use the volume slider to set the desired metronome level. 

8. Press the Go to Start button .

9. Make sure the Record Enable button on the track is on (it should be by 
default).

10. Press the Record button on the Cubase transport control panel. The button 
turns red and you’re recording.

11. When you’re finished recording your track, press the Spacebar, or press the 
Stop button on the Cubase Transport Control.

12. Press the Go to Start button .

13. Press the Spacebar or press the Play button to play back your new Track.

Record Another Track

14. Press the Go to Start button .

15. Drag the audio chunk you just recorded down below itself and release the 
mouse button. A new track is automatically created with your recording. This 
is a quick and easy way to set up a new track in Cubase. Now you’re all set to 
record again on Track 1.

16. Press the Record button on the Cubase transport control panel and you’re 
recording again. You’ll hear your first track playing along with you.

17. Repeat steps 12-14 to record more audio tracks.

18. Press the Mute button  to silence any tracks you don’t want to hear.

Record Enable

Record

PlayStopGo to Start

Drag
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Tutorials
3 - Recording a MIDI Track using Proteus VX

You’ll need a MIDI interface and a MIDI keyboard (or other MIDI input device) 
for this tutorial.

Make the Connections

1. Connect the MIDI out of your MIDI keyboard to the MIDI input of your MIDI 
interface.

2. From the Project menu, select Add Track, MIDI.

The Cubase Project Window should now look more or less like the one below 
with one or more Audio tracks and one MIDI track:

3. Click the Devices menu, and select VST Instruments.

MIDI Track
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Tutorials
4. From the VST Instruments window, select E-MU, then ProteusVX.

The VST Instruments window now looks like this.

5. Take a look at the Inspector area on the left side of the Cubase LE project 
window. Make sure the input to the MIDI track is connected to the input of 
your MIDI Interface or USB MIDI controller. 

6. The Output is not yet connected to anything. Click on the Output and select 
ProteusVX.

7. Click the Edit button  of the VST Instruments window to open the Proteus 
VX. Alternatively, you could click on the Edit button of the track Inspector to 
open Proteus VX.

8. Next, you need to load the Proteus X Composer bank. Select Proteus VX from 
the File menu.  The banks is installed here: “Program Files/Creative Profes-
sional\ E-MU Sound Central\Proteus X Composer.” Loading takes a few 
seconds.

9. Bring up the mini keyboard by clicking the icon on Proteus VX and play a 
few notes. You should be hearing sound. If not, verify that the 0202 USB 2.0 is 
properly configured.

10. Play your MIDI controller and verify that it plays Proteus VX.

11. Change the Preset using the inc/dec keys of the prg: field of the inspector. 
 The preset on Proteus VX should change to follow the one 

in Cubase LE. If not, make sure the Receive Program Changes box is checked 
in Proteus VX (Options, Preferences..., MIDI).

12. Feel free to play around for awhile and don’t worry about losing anything. 
Nothing is made permanent until you Save the bank, so have fun.

Edit Button
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Tutorials
To Record a MIDI Track

13. Make sure the Record Enable button on the MIDI track is on (it should be by 
default).

14. Click Record on the Cubase LE Transport control and start playing your MIDI 
controller.

15. Press Stop when you’re finished recording the first track.

16. Press the Go To Start button .

17. Press Play  on the Cubase Transport to play back your track.

To Record a MIDI Track on another MIDI Channel

TIP . . .
Proteus VX VSTi can play 
back up to 16 MIDI tracks at 
once. It’s much more 
efficient to use several 
channels on one VSTi than 
to use multiple VSTi’s with 
one channel each.

18. From the Project menu, select Add 
Track, MIDI. Notice that the channel 
number in the Inspector section is now 
set to chn:2.

19. Select Proteus VX as the Output destina-
tion in the Inspector section.

20. Select a new Preset for this track using the inc/dec keys of the prg: field of the 
inspector. 

21. When you’re ready, click Record on the Cubase LE Transport and start play-
ing.

22. Click Stop when you’re finished recording, press the Go to Start button on 
the transport, then Play. Proteus VX now plays both MIDI channels.

On Your Own
Cubase LE and Proteus VX include excellent online documentation and help files. 
Take the time to learn all the features of these powerful programs, and most of all 
have fun.

Record Enable

Record

Channel
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Getting Started with Cakewalk Sonar LE (Windows only)
Sonar LE is a 24-bit multi-track audio/MIDI sequencer with high-quality effects, 
automation, virtual instruments (VSTi/DXi), and many other professional features.

IMPORTANT: During installation of Sonar LE you will be asked to run the 
Cakewalk VST Adapter. You must do this in order for Sonar to recognize Proteus 
VX or any other VST plug-ins.

The following step-by-step tutorials are designed to get you recording on Sonar LE. 
After you finish the tutorial we encourage you to read the Sonar LE PDF manual in 
order to learn about the many features of this comprehensive program.

1 - Setting up Sonar LE
Follow these instructions carefully to ensure that Sonar LE runs smoothly the first 
time. Sonar LE will remember these settings, so you’ll only have to do this once.

Run Sonar LE for the first time

1. Open Sonar LE from the Start menu or by double-clicking on the desktop 
shortcut. The first time you run Sonar LE, the following dialog box appears:

2. Click No to close the dialog box. (The tests do not apply to the 0202 USB 2.0.) 
Sonar LE opens and the following dialog box appears.

3. Click Close to close the dialog box. The Sonar Project Window appears.
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Set-up the Audio Options

4. From the Options menu, select Audio. The following dialog box appears.

5. Click on the Advanced Tab to access the next window.

6. Select ASIO as the Driver Mode and click OK. You’ll get a pop-up dialog box 
explaining that the ASIO settings won’t take effect until the next time you start 
Sonar LE.

7. Close Sonar LE completely and restart the application.
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Return to the Audio Setup Options

8. Once Sonar LE has restarted, select Audio from the Options menu. 

9. Click the ASIO Panel. The pop-up dialog box 
shown at right appears.

10. Set the ASIO Buffer Latency as low as your com-
puter will allow. A low latency setting is impor-
tant to assure fast response when using virtual 
instruments and to minimize delay when moni-
toring through Sonar LE. If you hear crackles or 
other audio problems, try increasing the Buffer 
Size. 

11. Close the Audio Options screen by clicking OK.

Note: If the Sonar LE application crashes for any 
reason, it is recommended that you re-boot the 
computer.

Set the Location of your Audio Files

TIP . . .
If you have two or more 
hard disks, it’s better to store 
audio files on a disk that 
isn’t running your OS.

12. From the Options menu, select Global.

13. Select Audio Data, then select a location for the Global Audio Folder. 
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2 - Basic Multitrack Recording
This tutorial assumes you’re using a single input or pair of inputs. For more 
advanced recording, refer to the Sonar LE manual. Sonar opens by default with 
with 2 audio tracks and 2 MIDI tracks.

1. Click the Restore Strip Size 
button for Track 1. This reveals 
the input and output routing of 
the track. The E-MU 0202 USB 
2.0 will already be selected as the 
output destination.

2. Select the input source by clicking on the small triangle on the input field. If 
you wish to record a mono signal on the Left input of the 0202 USB, select 
Left ASIO E-MU 0202|USB Analog In A. To record both inputs in stereo select 
Stereo ASIO E-MU 0202|USB Analog In A.

3. The Input Echo button should be OFF. You will be monitoring the input 
through the E-MU 0202.

4. Press the Direct Monitor button on your E-MU 0202 USB 2.0. If you are 
recording a mono track, set Direct Monitor to Mono by pressing the Direct 
Monitor button again.

TIP . . .
If you don’t see meter 
activity on the track, check 
the Input for the track. 
Make sure you are selecting 
the proper input source.

5. Press the Track Record Enable button  for the track. (See the diagram 
above.) The track turns a dull red color to indicate that it is record-enabled. 
You should now see activity on the Track Input Meter when feeding a signal 
into the 0202 USB 2.0.

The Sonar Project Window

Track Record Enable
Step 3

Inspector Restore Strip Size

Input Click 
Here

Output
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6. If your input signal is either too weak or too strong, adjust the input level 
control on the 0202 USB 2.0.

7. Optional Step - Metronome: First, select Toolbars from the View menu and 
check the Metronome Toolbar. Next turn Metronome During Record On by 
clicking the button.

Record a Track

8. Press Record on the Sonar LE Transport control and start playing.

9. Press Stop when you’re finished recording the first track.

10. Press Play on the Sonar LE Transport to play back your track.

11. If you want to dump the track and start over, Right-click over the waveform 
display in the track and choose Delete.

Record Another Track

TIP . . .
You can create a new track 
by selecting Clone, from the 
Track menu. This handy 
feature duplicates the 
currently selected track 
complete with input/output 
routings.

12. Select Track 2 and click the Restore Strip Size button  to expose the input 
and output routing.

13. Set the Input source for the track. Click on the little triangle  on the right 
side of the track Input box. 

14. Disable record for Track 1 by clicking on the Track Record button Off. 

15. Enable recording for Track 2 by clicking on the Track Record button On.

16. Press the transport Record button and you’re recording.

Hot Tip: A quick way to record additional tracks using the same input is to simply 
drag the Part (audio region) you just recorded up or down to another track in the 
Sonar Project Window, then just hit Record again and go. (Choose Blend Old and 
New when asked in the Drag & Drop Options.)

Save your Project

17. Choose Save As… from the Sonar LE File menu to save your project. Choose a 
name and location that will make the project easy to find later.

Input Select

Output Select

Record

Play

Stop

Return-To-Zero
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3 - Recording a MIDI Track using Proteus VX
These instructions explain how to start Proteus VX from within Sonar LE. You’ll 
need a MIDI interface and a MIDI keyboard (or other MIDI input device) for this 
tutorial. 

• Important: If Sonar was installed BEFORE Proteus VX VSTi, you will have to 
run the Cakewalk VST Adapter before Sonar can use the VSTi. (Start, 
Programs, Cakewalk, Cakewalk VST Adapter).

1. Connect the MIDI output of your MIDI keyboard to the MIDI input of your 
MIDI interface.

Select the Virtual Instrument

2. Select Synth Rack from the View menu. The following window appears:

3. Click on the + symbol to add an instrument. Follow the path shown above 
and select Proteus VX from the list of VST instruments. The following pop-up 
dialog box appears.

4. Select the default options (MIDI Source Track & First Synth Output) as shown. 
Click OK to continue. (This may a take a few seconds.)

5. Proteus VX now appears in the Synth rack and two new tracks have been 
added to the bottom of the track list. (You may have to scroll down to see the 
new tracks.)

Click Here

Audio Output from Proteus VX
MIDI input to Proteus VX

Click Here to view the strip controls.

New Proteus VX Tracks
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The MIDI Connection

6. Select the blue MIDI Input track by clicking on it. The MIDI Input connection 
appears in the strip to the left of the MIDI tracks.

7. Your MIDI Interface should already be selected as the MIDI input in Omni 
mode as shown above. “MIDI Omni” allows Proteus VX VSTi to receive on all 
16 MIDI channels from your MIDI keyboard. (Proteus VX VSTi is “multi-
timbral” and can assign a different preset to each of the 16 MIDI channels.)

TIP . . .
Check the Sonar MIDI 
Monitor in the SysTray to 
verify that you’re receiving 
MIDI.

8. Set the MIDI Channel for the track to 
channel 1 as shown at right. This “re-
channelizes” the incoming MIDI data on any 
MIDI channel to channel 1.

Open Proteus VX

9. Double-click on the number (or on the Proteus VX name) to open the Proteus 
VX editor.

MIDI Input Select

Synth Rack with Proteus VX

Double-Click Here
to Open Proteus VX
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10. After a few seconds, the Proteus VX editor screen shown below appears.

Play the Proteus X Composer Bank.

11. Select the 16 channel tab. This page allows you to select presets for all 16 MIDI 
channels.

12. Select a preset for MIDI Channel 1 by clicking the little triangle.

13. Play your MIDI keyboard and verify that it plays Proteus VX.

14. Feel free to play around for awhile selecting presets and exploring Proteus VX. 
Don’t worry about losing anything. Nothing is made permanent until you 
Save the bank, so don’t worry and have fun.

16 Channel Tab Select Preset
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To Record a MIDI Track

15.  Minimize the Proteus VX window by pressing the minimize button . 

16. Record-Enable the MIDI Track by pressing the track Record button (R). The 
track turns a dull red color to indicate that it is record-enabled.

• Important: Be sure to turn Track Record Enable OFF for any tracks you don’t 
want to record on, such as previously recorded tracks.

17. Press Record on the Sonar LE Transport control and start playing.

18. Press Stop when you’re finished recording the first track.

19. Press Play on the Sonar LE Transport to play back your track.

To Record a MIDI Track on another MIDI Channel

Proteus VX VSTi can play back up to 16 MIDI tracks at once. It’s much better to use 
several channels on one VSTi than to use multiple VSTi’s with one channel each.

20. Select MIDI Track from the Insert menu.

21. Select the MIDI input for the new MIDI track. Select MIDI Omni as you did 
before.

22. Select Proteus VX as the Output destination for the track.

23. Select MIDI Channel 2 in the Ch. field as shown below.

24. Restore Proteus VX by clicking on the Restore Up button on the minimized 
Proteus FX window. Select a preset for channel 2 by clicking the little triangle 
on channel 2 in the 1-16 channel view of Proteus VX.

25. Play your MIDI keyboard to listen to the presets during the selection process. 
Click OK when you’ve made your selection.

26. Record Enable the track by pressing the Track Record Enable button . If 
you want to record multiple tracks simultaneously, simply turn Record Enable 
on for each track you wish to record.

27. Press Record on the Sonar LE Transport control and start playing.

28. Press Stop when you’re finished recording the second track.

On Your Own
Now that you’ve had a taste of what Proteus VX can do, please read the Proteus VX 
Operation Manual PDF to learn all about this exceptional instrument.

Sonar LE also includes useful online documentation and help files to help you 
learn about the features of this powerful program.

Track Record Enable

Input Select

Output Select

MIDI Ch. Select

Chan. 2 
Selected
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Getting Started with Ableton Live Lite 4 (Windows/OS X)
This guide contains a basic walk-through of Ableton Live Lite 4 (E-MU Edition) to 
get you recording and playing back audio. A Proteus VX tutorial is also included for 
Windows users. We encourage you to perform the steps on your computer as you 
read so that you can “learn by doing.”

Ableton Live Lite 4 is an innovative composition and performance tool. Live 
combines digital recording, virtual instruments, and digital effects with an original 
interface design that many people find more intuitive than traditional designs.

The following step by step tutorials are designed to get you recording as quickly as 
possible. After you’ve finished the tutorial we encourage you to follow Ableton 
Live’s excellent interactive Lessons and read the Ableton Live reference manual pdf 
in order to learn more about the program.

Before you Begin:

• You should have already installed the 0202 USB 2.0 and software on your 
computer according to the instructions in your printed “Getting Started” 
manual.

• You should have already installed the Ableton Live Lite 4 software on your 
computer according to the instructions provided with the Ableton software.

NOTE
The first time you run Live, 
you may get the message, 
”Audio is disabled. Please 
choose an audio output 
device from the Audio 
Preferences.” Simply follow 
the instructions in “1-Setting 
up the Preferences” to 
correct the situation.

• You should hear sounds from Ableton Live Lite 4 when you play the Ableton 
demo.

• You should have your MIDI interface and keyboard connected if you want to 
record MIDI.

1 - Setting up the Preferences
Unlock Ableton Live Lite 4 for E-MU by following the instructions in the Prefer-
ences menu. (Windows - Options menu, Preferences; OS X - Live menu, Preferences) 
Read the following instructions to configure the Audio and MIDI preferences. Live 
will remember these settings, so you’ll only have to do this once.

Set up the Plug-ins
The following steps allow Ableton Live Lite 4 to find the VST Plug-ins and Proteus VX.

1. Click on the Plug-ins tab of the Preferences dialog box under the Options 
menu (Windows) or Live menu (OS X). The following screen appears.

WindowsOS X

Locate: Steinberg\VSTplugins

1. Turn On: “Use Audio Units “ & “VST Plug-in System Folders”
2. Re-Scan Plug-ins
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OS X Users

2. Turn on Use Audio Units. 

3. Turn on Use VST Plug-in System Folders.

4. Press the Re-scan Plug-ins button. (You may have to wait a few seconds.)

Windows Users

5. Press the Browse button, then locate VST Plug-ins located in the Steinberg 
folder. (Default path: C:\Program Files\Steinberg\VstPlugIns\)

NOTE
Windows Users: If the plug-
ins do not appear after 
selecting the proper folder, 
press the Re-scan button.

6. After selecting the VST plug-ins folder, press OK. (You may have to wait a few 
seconds while Ableton locates the plug-ins.)

Set up the Audio Parameters

7. Click the Audio tab of the Preferences dialog box. The Audio Setup page 
appears.

8. Windows Users:Select ASIO and ASIO E-MU 0202|USB as the Audio Device.
OS X Users: Select Core Audio and E-MU 0202|USB as the Audio Device.

Set up the MIDI Parameters

NOTE
Live enables every MIDI 
input by default 

9. Click the MIDI/Sync tab of the Preferences dialog box. The MIDI Setup page 
appears.

10. Your MIDI interface or USB MIDI keyboard should appear in the list. Make 
sure it’s selected.

11. Preference Setup is now complete. Click the close button to close the window.

WindowsOS X

Set up the Audio Parameters as shown above.

OS X Windows

Select 
MIDI 

Interface 
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2 - Playing Audio Clips
Ableton Live Lite contains a bunch of great pre-recorded audio clips. In this short 
section, you’ll learn to select and play clips.

1. Select New Live Set from the File menu. A new Ableton Live set opens with 
two audio tracks and two MIDI tracks such as the one shown below. If the 
window doesn’t look like the one below, click the Session View button.

2. Follow the three steps shown above in the diagram to open the “breaks 
Sounds” folder. Note: On the Macintosh, the folder “Starter Sets” is located 
inside the “Demos and Tutorials” folder.

3. Drag and drop the drums01-1.wav and drums01.wav clips over to Audio 
Track 1.

4. Now click on the Clip Launch Button (little triangle)  on one of the 
clips you just dragged over. The loop begins playing. To stop playing, press the 
Stop button on the transport.

5. Click the Clip Launch Button on the other clip. The new clips begins as soon 
as the first one is finished.

6. Try out more pre-recorded audio clips. (To delete a clip, just select it and press 
Delete.)

7. Press the Stop button  in the Transport to stop playing.

8. When you’re finished exploring, and are ready to go on to the next tutorial, 
just make sure that you have at least one drum clip in Audio Track 1 and one 
empty slot in Audio Track 2.

Show/Hide In/Out Section

Note...
On the Macintosh, 
the folder “Starter 
Sets” is located 
inside the “Demos 
and Tutorials” folder.

Session View Button

Click Here
File Browser 1

Open Folder
Starter Sets

Open Folder
breaks Sounds

Drag & Drop
Drum Clips
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3 - Recording Audio into Ableton Live

1. Select an empty Audio Track with no clips.

2. From the View Menu on Ableton Live, select In/Out. 
(Alternatively, you could also click the “Show/Hide In/Out Section 
button” as shown in the diagram on the previous page.) Several 
more options now appear in the mixer strips.

3. Input channels 1/2 are selected by default (stereo). If you 
want to record a mono track select input 1 or 2 from the 
drop-down menu. 

4. Feed an input signal into the 0202|USB 2.0 from a guitar, keyboard, CD 
player or other audio source. A mini-meter appears in the input selection field. 

The mini-meter should appear green. If not, reduce the input level.
NOTE
Direct monitoring can be 
turned Off on the 0202 USB 
2.0 since we’re monitoring 
through Ableton Live 
(Auto).

5. Press the Arm Session Record button located at the bottom of the strip. 
The button turns red. You should now hear your input signal if Monitor is set 
to Auto.

6. Start one of the Drum Clips and practice playing along with a short riff.

7. When you’re ready to record, click on the empty circle  in one of the empty 
clips in Track 2. Recording begins immediately. After recording a bar or two, 
hit the Space Bar to Stop.

8. Double-click on the audio clip you just recorded and it appears below the 
mixer section as shown below. Play both clips back by clicking Play button  
above the mixer section. Make sure your recorded loop plays in time with the 
drums. If not, delete the audio clip and re-record it.

9. Click and drag the 1 Warp Marker over to the beginning of your recording as 
shown below.

TIP . . .
If your clip doesn’t loop, 
make sure the Loop button 
is pressed.

10. Next, drag the Loop End marker to make your loop the desired length.

11. Press Play. Your loop should now play in time with the drum loop.

1 Warp Marker

Loop End Marker
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4 - Running Proteus VX VSTi from Ableton Live (Windows only)

NOTE
These instructions also 
apply to Proteus X or 
Emulator X.

These instructions explain how to run Proteus VX from within Ableton Live Lite 4. 
Ableton Live’s forte is making it easy to combine pre-recorded audio and MIDI 
clips in new and exciting ways. In this tutorial, you’ll learn how to use a MIDI 
keyboard or the pre-recorded MIDI loops that come with Ableton Live Lite 4 to 
play Proteus VX.

1. Select New Live Set from the File menu. A new Ableton Live set opens with 
two audio tracks and two MIDI tracks such as the one shown below. If the 
window doesn’t look like the one below, click the Session View button.

Select Proteus VX as a Virtual Instrument

2. Click on the Plug-in Device Browser button  on the left side of the window. 
The list of Ableton Plug-ins appears at the left side of the window.

3. Select Proteus VX from the Plug-ins list and drag it 
over the MIDI Track heading as shown above. Wait a 
second or two, then you’ll see the Proteus VX VSTi 
appear in the MIDI Track View area below the mixer.

Load the Proteus VX Bank

4. Click on the wrench icon  on Proteus VX in the area 
below the mixer. See the image at right.

1. Click
Here

to open
Plug-ins

2. Drag
Proteus VX

3. Drop Here Session View button

Step 2:
Plug-in Device Browser

Step 4:
Select Wrench Icon
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5. The Proteus VX application window shown below appears.

Load the Proteus X Composer Bank

6. Proteus VX is now running, but you need to load a bank of sounds.

7. Choose Open from the File menu on Proteus VX. Locate and load the Proteus 
X Composer bank, which is located here: (“Program Files/Creative Profes-
sional/E-MU Sound Central”). This big bank takes a few seconds to load.

Play the Proteus X Composer Bank

TIP . . .
If you’re not hearing sound, 
go to the Ableton Prefer-
ences and make sure that 
the Driver Type is set to 
ASIO and the Audio Device 
is set to ASIO E-MU 
0202|USB.

8. Bring up the mini keyboard by clicking the icon on Proteus VX and play a 
few notes.

9. Change the Preset using the preset inc/dec keys.  Cool sounds! 
Whenever you’re ready, drag the Proteus VX window off to the side so you can 
access the Ableton window.

10. From the View Menu on Ableton Live, select In/Out. Several 
more options now appear in the mixer strips.

11. Select your MIDI interface in the “MIDI From” field and turn 
Monitor On as shown at right. Now you can use your MIDI 
keyboard.

12. Feel free to play around for awhile and don’t worry about 
losing anything. Nothing is made permanent until you Save 
the bank.

13. When you’re ready to move on, set the Monitor to Auto, select preset P0004 A 
KuStq, then close the Proteus VX editor by clicking on the close box .

Play MIDI Clips

14. Locate MIDI Loops by Keyfax in the Factory Content section of the Ableton 
Live Lite 4 Browser. 

15. Click on the folder to open it. You’ll see a bunch of other folders.

16. Open the first folder, BRK_120. Next, open the next folder BRK-Bass.mid. 
Now, you’ll see a MIDI file named BRK-Bass.

Mini Keyboard

Step 14:
Locate MIDI Loops
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17. Click and drag BRK-Bass over one of the clip slots in the 3 MIDI strip as 
shown below.

18. Now click on the Clip Launch Button (little triangle)  on the MIDI clip you 
just dragged over. The MIDI bass loop begins playing the bass preset on 
Proteus VX. To stop playing, press the Stop button.

19. Find some other MIDI loops and drop them into the other slots of the track. 
Hint: look in different folders. Click on the Clip Launch Buttons to switch 
between clips.

Add Another MIDI Track
Ableton Live Lite 4 allows four MIDI tracks, so let’s play a different MIDI loop and 
sound on track 4 MIDI.

20. Choose a different MIDI loop such as House-Lead, (located in the HOUSE-
120 folder) and drop it onto one of the 4 MIDI clip slots.

21. Currently, the MIDI To box reads “No Output”. Instead, select 3-MIDI. 
Another option box labeled “Track In” now appears beneath 3-MIDI.

22. Click on the Track In box to see the list of MIDI channels.

Show/Hide In/Out Section

Stop

Select 
3-MIDI
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23. Select MIDI Channel 2 as shown at right.

24. Click on the Clip Launch Button  on the 4 MIDI clip to get it started. You 
won’t hear anything because you haven’t yet assigned a preset to MIDI 
channel 2 on Proteus VX.

Choose a Sound for MIDI Channel 2

25. Click on the 3 MIDI heading to show the Proteus VX VSTi. Next, click on the 
wrench icon  again (in the MIDI Track View) to open Proteus VX.

26.  Select MIDI Channel 2 using the channel inc/dec keys .

27. Select a Preset on Channel 2. Place the cursor in the preset number field and 
use the up/down arrow keys on your computer keyboard to scroll through the 
list until you find a preset you like.

• Note: There are several ways to select presets. See the Proteus VX Operation 
manual pdf for details.

28. Now you should be hearing the sound you chose on channel 2. If not, check 
to make sure both clips are playing (green triangle). Each clip plays a different 
preset.

Add MIDI Clips

NOTE
Proteus VX sounds are 
called Presets or Programs. 
Ableton Live Programs are 
offset by +1 from Proteus 
VX.

29. Drop a few more MIDI clips into both MIDI channel slots. Play around with 
the Clip Launch buttons.

Preset Change
Here’s another way to change the MIDI Program (Preset in E-MU speak) without 
going into the Proteus VX editor.

30. Double-click on one of the currently playing MIDI clips. The Clip View 
appears at the bottom of the window.

31. Select the Show/Hide Notes Box  located in the lower left corner of 
the Clip View window. The Notes box appears in the Clip View section. 

32. Select a Program number. You’ll hear the Proteus VX sound change. Keep 
selecting until you find one you like.

• Hint: Use the Up/Down Arrow keys to select Programs. Use Sub-Banks 2-8 
to select presets higher than 128.

33. As an added bonus of selecting programs this way, the program (sound) you 
selected is now associated with the MIDI clip. Whenever you select this MIDI 
clip, the sound will also be selected.

34. Select another clip and assign a different program number. Notice that the 
Preset changes when you switch back and forth between clips.

Save the Set

35. Save your work by selecting Save Live Set As… from the File menu. The next 
time you load the set, the Proteus VX bank will automatically load as well.

Record a MIDI Track using your MIDI Keyboard

36.  You can use the MIDI Track you set up on MIDI channel 2. Make sure there is 
at least one empty slot in the MIDI track. (Select and hit backspace to delete a 
clip.) 

• If your MIDI interface isn’t already connected, you’ll have to quit Ableton 
Live Lite 4, connect the MIDI interface, then restart Ableton Live Lite 4 before 
continuing.

Select
Preset

Notes Box
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37. Set up the MIDI track as shown at left.

a. Select your MIDI Interface in the “MIDI from” field.

b. Set the input to listen to MIDI channel 2.

c. Monitor should be set to Auto.

d. This field routes the MIDI data to track 3 (which contains Proteus VX).

e. Set the output to MIDI channel 2.

f. Turn record On (red).

38. Set your MIDI Keyboard to transmit on MIDI channel 2.

39. Play the keyboard. You should hear Proteus VX playing the last sound you 
selected on channel 2. Go ahead and change the sound if you wish. (Double-
click the top of Track 3, then click the Wrench icon on the Device Title Bar. 
Make sure you’re changing the sound on channel 2.)

Ready to Record

40. Start up the bass line on track 3 MIDI and practice playing along with it.

41. Optional: You can set the Global Quantization value to time correct your 
playing. Set it to anything other than “None”.

42. Click one of the round MIDI Clip Record buttons to begin recording.

43. Click the Clip Launch button, the Clip Stop button, or the Spacebar to stop 
recording.

On Your Own
Now you’ve had a taste of what Proteus VX and Ableton Live Lite 4 can do. But 
don’t stop now! Read the Proteus VX Operation Manual pdf to learn all about this 
exceptional instrument.

Ableton Live Lite 4 includes several excellent hands-on tutorials to help you learn 
all the features of this ground-breaking music application.

Other Cool Tips

• To control Proteus VX with the knobs on your MIDI keyboard: 
Go to the MIDI Preferences on Proteus VX (Options, Preferences, Controllers 
tab) and make sure the MIDI Continuous Controller numbers match the ones 
your keyboard is sending. You can change the controller numbers on either 
your MIDI keyboard or Proteus VX, just as long as they both match.

• To control Proteus VX with the Assignable X/Y Controls in Live: 
Simply select the Proteus VX Channel and Proteus VX controller letter A-M for 
each axis of the X/Y controller. Open Proteus VX to see what controllers A-M 
are controlling. For more information about MIDI controllers please refer to 
the Proteus VX pdf manual.

a

b

c

d

e

f

Quantize

Assign Controllers
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TROUBLESHOOTING

Can’t hear Windows Media Player in Windows
If you have, or ever have had, another audio device installed in your PC, you may 
have to set the E-MU 0202 USB 2.0 as the “Default Audio Device”.

1. Open the Control Panel, then select Sounds and Audio Devices.

2. Click the Audio tab and select the E-MU 0202 USB 2.0 as the Default device 
under Sound Playback.

3. Click the Volume button under Sound Playback and turn up Wave volume.

You cannot record or monitor ASIO and WAVE at the same time. The first audio 
application you open controls the E-MU 0202 USB 2.0.

Lost Communication
Should you lose communication between your E-MU 0202 and an audio appli-
cation (Ableton Live, Cubase, Sonar, etc.), the E-MU 0202 USB 2.0 drivers may 
need to be re-selected in your application.

1. Go to your application's I/O settings, de-select the E-MU 0202 USB 2.0 for 
both input and output.

2. Apply these changes and exit the dialog.

3. Re-enter the application's preference settings and re-select the E-MU 0202 USB 
2.0 drivers. If this doesn’t work, the application may need to be restarted.

Ground Loops
In digital audio devices and computers, audio ground loops may appear as pitched 
tones, digital hash in the background, as well as the familiar 60 cycle hum. 

Ground loops are caused by a difference in ground potential between two pieces of 
equipment. Computer audio devices are particularly susceptible to ground loops 
because most computers were not designed with high quality audio in mind.

The E-MU 0202 USB 2.0 contains built-in “ground lift” switches for both analog 
inputs in order to safely break the loop if a ground loop occurs in your setup.

The ground-lift switches are located on the bottom of the unit, close to the rear 
panel. The input ground is lifted when the A or B slide switch is closest to the GND 
LIFT label.

Pops & Crackles
Pops and crackling noises in the audio are most often caused by having the ASIO 
Buffer Size set too low. Adding audio tracks and VST plug-ins increases the load on 
your computer’s CPU. If your computer cannot keep up with all the tasks you are 
asking it to perform, pops and crackles may occur. In effect, increasing the ASIO 
buffer gives your computer “more time” to complete its assigned tasks. The 
hardware Direct Monitor feature of the 0202 USB 2.0 allows you to increase the 
ASIO Buffer setting without the associated latency problems during recording and 
overdubbing.

USB hubs can create problems with digital audio and should be avoided whenever 
possible.

L-GND LIFT
R-GND LIFT

Input Ground Lifted

Input Grounded
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Internet References
Simultaneous WDM/ASIO Playback (PC only)
The 0202 USB 2.0 only supports playing back one stream format at a time on the 
PC. Each of the three mentioned stream types has an associated priority. If a higher 
priority stream type is opened while a lower priority stream is already playing, the 
lower priority stream will stop playing. The stream priorities, from highest to 
lowest, are ASIO, WDM.

USB 2.0 vs. USB 1.1 Operation (PC only)
The 0202 can operate in USB 2.0 or USB 1.1 mode on the PC. 96 kHz and 192 kHz 
sample rates are only available while operating in USB 2.0. The included E-MU 
USB Audio Control panel software includes an indicator to let the user know 
which mode the device is running in.

0202 USB comes up in USB 1.1 mode (PC only)
Always turn the 0202 USB power off before connecting or disconnecting the USB 
cable. Hot-plugging the unit with the power on can cause the 0202 to power-up in 
USB 1.1 mode. If you see the Windows message, “This device could perform 
faster…”, simply turn power off, wait a few seconds, then turn power on again.

INTERNET REFERENCES
The internet contains vast resources for the computer musician. A few useful sites 
are listed here, but there are plenty more. Check it out.

Software Updates, Tips & Tutorials.. http://www.emu.com/support

Setting up a PC for Digital Audio ..... http://www.musicxp.net

MIDI Basics .......................................... Search for “MIDI Basics” (many sites)

MIDI & Audio Recording ................... http://www.midiworld.com

MIDI & Audio Recording ................... http://www.synthzone.com

Sonar Users Group ............................  http://www.cakewalknet.com/index.php

Cubase, ASIO & Digital Audio .......... http://www.steinberg.net

ASIO, Cubase & Digital Audio ..........  http://www.steinbergusers.com/cubasele/
le_support.php

Cubase Users Group ........................... http://www.groups.yahoo.com/group/
cubase/messages

Forums

Unofficial E-MU Forum ..................... http://www.productionforums.com/emu

Sound-On-Sound Forum ................... http://www.soundonsound.com

Computer Music Forum..................... http://www.computermusic.co.uk/main.asp

Home Recording Forum .................... http://homerecording.com/bbs

Studio Central Forum ........................ http://www.tweakheadz.com

KVR Forum........................................... http://www.kvr-vst.com/forum/search.php

MIDI Addict Forum ...........................  http://forum.midiaddict.com/search.php

Sound Card Benchmarking ............... http://audio.rightmark.org

Driver Heaven Forum......................... http://www.driverheaven.net
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Technical Specifications
TECHNICAL SPECIFICATIONS

General
Sample Rates: 44.1, 48, 88.2, 96, 176.4, 192kHz from internal crystal with no 

sample rate conversion 
(Note: 176.4k & 192k sample rates not supported on Macintosh)

Bit Depth: 24-bit I/O, 32-bit processing

USB 2.0 Hi-Speed

Full 24-bit resolution at all sample rates
2in/2 out channels 

Zero-latency direct hardware monitoring (disabled at 176.4/192kHz)

ASIO2, WDM MME, Apple Core Audio and Core MIDI drivers

Anti-Pop speaker protection minimizes noise during power on/off

Ultra-low jitter clock subsystem: <100ps RMS

Combo Microphone Preamplifier/Hi-Z/Line Input (1)
Type: Balanced E-MU combo mic preamplifier and Hi-Z/line input

A/D converter: AK5385A

Input Impedance: 1.5 Kohms

Max Level: +6.5dBV (+8.7dBu)

EIN: (20Hz-20kHz, 150ohm, unweighted) -127dBu

Signal-to-Noise Ratio: (A-weighted, min gain) 113dB

THD+N: (1kHz at -1dBFS, min gain) -103dB (.0007%)

Gain Range: +60dB

Frequency Response: (min gain, 20Hz-20kHz) +0.0/-0.16dB

Stereo Crosstalk: (1kHz min gain, -1dBFS) < -110dB

Hi-Z/Line Input (1)
Input Impedance: 1 Mohm

Max Level: +12dBV (14.2dBu)

Dynamic Range: (A-weighted, 1kHz, min gain) 113dB

Signal-to-Noise Ratio: (A-weighted, min gain) 113dB

THD+N: (1kHz at -1dBFS, min gain) -101dB (.0009%)
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Technical Specifications
Analog Line Outputs (2)
Type: unbalanced, AC-coupled, 2-pole low-pass differential filter

D/A converter: CS4392

Max Level: Consumer: +6.7dBV max (unbalanced)

Frequency Response: (20Hz - 20kHz) 0.00/-.01dB

Dynamic Range: (1kHz, A-weighted) 111dB

Signal-to-Noise Ratio: (A-weighted) 112dB

THD+N: (1kHz at -1dBFS) -98dB (.0013%)

Stereo Crosstalk: (1kHz at -1dBFS) < -120 dB

Headphone Amplifier
Type: Class-A power amplifier

D/A converter: CS4392 (shared with Line Out)

Gain Range: 60dB

Maximum Output Power: 16mW

Output impedance: 22ohms

Frequency Response: (20Hz–20kHz) +0.02/-0.08dB

Dynamic Range: (A-weighted) 110dB

Signal-to-Noise Ratio: (A-weighted) 108dB

THD+N: (1kHz, max gain): 300ohm load -98dB (.0013%)

Stereo Crosstalk: (1kHz at -1dBFS, 300 ohm load) < -91dB

Dimensions / Weight
Weight: 0.94 lb / 0.43 kg

Dimensions:

W: 6.5”   H: 2.0”   L: 5.5”

W: 165 mm  H: 50.8 mm   L: 140 mm
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Declaration of Conformity
DECLARATION OF CONFORMITY

Trade Name: E-MU Systems

Model No.: EM8740

Responsible Party: E-MU Systems

Address: 1500 Green Hills Road, Suite 101
Scotts Valley, CA 95066 U.S.A.

This device complies with Part 15 of the FCC rules. Operation is subject to the 
following two conditions: (1) This device may not cause harmful interference, and 
(2) this device must accept any interference received, including interference that 
may cause undesired operation.

CAUTION
You are cautioned that any changes or modifications not expressly approved in 
this manual could void your authority to operate this equipment.

Note:
This equipment has been tested and found to comply with the limits for a Class B 
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to 
provide reasonable protection against harmful interference in a residential instal-
lation. This equipment generates, uses, and can radiate radio frequency energy 
and, if not installed and used in accordance with the instructions, may cause 
harmful interference to radio communications. However, there is no guarantee 
that interference to radio or television reception, which can be determined by 
turning the equipment off and on, the user is encouraged to try to correct the inter-
ference by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to 
which the receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help.

The supplied interface cables must be used with the equipment in order to comply 
with the limits for a digital device pursuant to Subpart B of Part 15 of FCC Rules.
46 E-MU Systems



Declaration of Conformity
Compliance Information

United States Compliance Information

FCC Part 15 Subpart B Class B using:

CISPR 22 (1997) Class B

ANSI C63.4 (2003) method

FCC Site No. 958979

Canada Compliance Information

ICES-0003 Class B using:

CISPR 22 (1997) Class B

ANSI C63.4 (2003) method

Industry of Canada File No. IC 5933

European Union Compliance Information

EN55024 (1998 w/A1:01 & A2:03)

EN55022 (1998) Class B

Australia/New Zealand Compliance Information

AS/NZS CISPR 22 (2002) Class B using:

EN55022 (1998) Class B

Japan Compliance Information

VCCI (April 2005) Class B using:

CISPR 22 (1997) Class B

ANSI C63.4 (2003) method

VCCI Acceptance Nos. R-2160 & C-2332

Attention for the Customers in Europe
This product has been tested and found compliant with the limits set out in the 
EMC Directive for using connection cables shorter than 3 meters (9.8 feet).

Notice
If static electricity or electromagnetism causes data transfer to discontinue midway 
(fail), restart the application or disconnect and connect the USB cable again.
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Index
INDEX

A
Ableton Live Lite 4 for E-MU

changing presets  40
playing MIDI clips  38
running Proteus VX in  37
setting up  33
tutorial  33

Add Track, Cubase LE  21,  23
ASIO Buffer Latency  18,  26

C
Clip Indicators  13
Computer Requirements  7
Connection Diagram  12,  14
Continuous Controller numbers  41
Control Panel  18
Cubase LE

project window  17
setting up  17
tutorial  17

D
Device Select, E-Control  15
Device Setup, Cubase LE  18
Devices  21
Devices Menu, Cubase LE  18
Direct Monitor Controls  13
Direct Monitoring  16
Direct Monitoring vs Software Monitoring  16

E
E-Control Application  15
E-MU ASIO

Cubase LE  18
Sonar LE  25

G
Gain Controls  13
Ground Lift Switches  14,  42
Ground Loops  42

H
Headphone Level Control  13
Headphone Output  14

I
Inputs  14
Inspector, Cubase LE  22

L
Latency  16
Lost Communication  42

M
MIDI

channels, using multiple  40
clips, Ableton Live

adding  40
playing  38

continuous controller numbers  41
track

adding in Ableton Live Lite  39
MIDI Channels, using multiple  23,  32
MIDI Connection

Cubase LE  22
Sonar LE  30

MIDI Track
recording in Cubase LE  23
recording in Sonar LE  32

Monitor Button, Cubase LE  19
Monitoring, direct vs software  16
Multitrack Recording

Cubase LE  19
Sonar LE  27

O
Options Menu, Sonar LE  25,  26

P
Package Contents  8
Playing Audio Clips, Ableton Live Lite  35
Pops & Crackles  42
Preset Changes, Ableton Live Lite  40
Project Window, Cubase LE  17
Proteus VX

editor screen  31
using with Ableton Live Lite  37
using with Cubase LE  21
using with Sonar LE  29

Proteus X Composer Bank, loading  38
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Index
R
Recording a MIDI Track

Cubase LE  21
Sonar LE  29

Recording Audio
Ableton Live Lite  36
into Cubase LE  19
into Sonar LE  27

S
Save Live Set, Ableton Live Lite  40
Save Project, Sonar LE  28
Signal Level Indicators  13
Simultaneous WDM/ASIO/AC-3 Playback  43
Skin, selecting  15
Software Installation

Mac OSX  9
Windows XP  8

Sonar LE
multitrack recording  27
project window  27

Sub-Bank, Ableton Live Lite  40

T
Technical Specifications  44
Track Record Enable Button, Sonar LE  27,  32
Troubleshooting  42
Tutorials

Ableton Live Lite 4  33
Proteus VX with Ableton Live Lite  37

U
Uninstalling Drivers & App  8,  11
USB 1.1 port  14
USB 1.1 Warning Message  43
USB 2.0 vs. USB 1.1 Operation  43
USB Jack  14

V
VST Instruments  21
VST Plug-ins, locating in Ableton Live Lite  33

W
WDM/ASIO Playback  43
Windows Logo Testing Note  8
Windows Media Player, no audio  42

X
X/Y Controller, Ableton Live Lite  41
50 E-MU Systems


	Introduction
	Package Includes
	Computer Requirements
	Windows
	OS X

	Software Installation
	Windows XP
	Note About Windows Logo Testing
	Uninstalling all Audio Drivers and Applications

	Macintosh OS X
	Uninstalling the Audio Drivers and Applications


	Connection Diagram
	Controls & Headphone Output
	Input/Output
	E-MU USB Audio Control Panel
	Direct Monitoring
	Tutorials
	Introduction
	Before you Begin...

	Getting Started with Steinberg Cubase LE (Windows)
	1 - Setting up Cubase LE
	2 - Basic Multitrack Recording
	3 - Recording a MIDI Track using Proteus VX

	Getting Started with Cakewalk Sonar LE (Windows only)
	1 - Setting up Sonar LE
	2 - Basic Multitrack Recording
	3 - Recording a MIDI Track using Proteus VX

	Getting Started with Ableton Live Lite 4 (Windows/OS X)
	Before you Begin:
	1 - Setting up the Preferences
	2 - Playing Audio Clips
	3 - Recording Audio into Ableton Live
	4 - Running Proteus VX VSTi from Ableton Live (Windows only)
	Other Cool Tips


	Troubleshooting
	Internet References
	Forums

	Technical Specifications
	Declaration of Conformity
	Index



